
FORMATTING

Action Shortcut
Bold the selection [Ctrl]B

Italicize the selection [Ctrl]I

Underline the selection [Ctrl]U

Strike through the selection [Ctrl]S

Open the Style dialog box [Alt] and '

Open the Format Cells dialog box [Ctrl]1

Apply General format [Ctrl][Shift]~

Action Shortcut

Apply Currency format [Ctrl][Shift]$

Apply Percentage format [Ctrl][Shift]%

Apply Date format [Ctrl][Shift]#

Apply Time format [Ctrl][Shift]@

Apply Number format [Ctrl][Shift]!

Apply Exponential number format [Ctrl][Shift]^

Apply an outline border to selection [Ctrl][Shift]&

Remove outline border from selection [Ctrl][Shift] and _

This is a single-user version, and duplication is prohibited. For additional copies, please call 1-800-217-4339.
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KEYBOARD SHORTCUTS

NAVIGATION

Action Shortcut
Move to the next worksheet in a workbook [Ctrl][Page Down]

Move to the previous worksheet in a workbook [Ctrl][Page Up]

Cycle between open workbooks [Ctrl][F6]

Move one cell up, down, left, or right Arrow keys

Move to the edge of the data region [Ctrl] and an 
arrow key

Move to the beginning of a row [Home]

Move to the end of a row [End]

Move to the beginning of a worksheet [Ctrl][Home]

Action Shortcut
Move to the end of the used portion of [Ctrl][End]

a worksheet

Move between panes in a split worksheet [F6]

Display the active cell [Ctrl][Backspace]

Move down a cell in a selected range [Enter]

Move up a cell in a selected range [Shift][Enter]

Move one cell to the left in a selected range. [Shift][Tab]

Move from corner cell to corner cell in [Ctrl] and .
a selected range (period)

SELECTION TECHNIQUES

Action Shortcut
Select a row [Shift][Spacebar]

Select a column [Ctrl][Spacebar]

Select an entire worksheet [Ctrl]A

Select from current cell(s) to the beginning [Shift][Home]
of the row

Select from current cell(s) to last used      [Shift][End][Enter]
cell in row

Select from current cell(s) to the beginning [Ctrl][Shift][Home]
of the worksheet

Action Shortcut
Select from current cell(s) to the end of [Ctrl][Shift][End]

the used portion of a worksheet

Select the array that contains the active cell [Ctrl]/

Select the data region surrounding the [Ctrl] and *
active cell

Select all cells that contain a comment [Ctrl][Shift]O

Select cells that a selected formula [Ctrl] and [
directly references

Select formulas that directly reference [Ctrl] and ]
the active cell

WORKBOOK BASICS

Action Shortcut
Open a workbook [Ctrl]O

Create a new workbook [Ctrl]N

Save a workbook [Ctrl]S

Open the Save As dialog box [F12]

Print a workbook [Ctrl]P

Close a workbook [Ctrl]W

Insert a new worksheet [Shift][F11]

Hide selected rows [Ctrl]9

Action Shortcut
Display hidden rows in selection [Ctrl][Shift]9

Hide selected columns [Ctrl]0

Display hidden columns in selection [Ctrl][Shift]0

Open the Find tab of the Find And Replace [Ctrl]F
dialog box

Open the Replace tab of the  [Ctrl]H
Find And Replace dialog box

Run a spelling check on a worksheet [F7]
or selected text
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KEYBOARD SHORTCUTS continued

This is a single-user version, and duplication is prohibited. For additional copies, please call 1-800-217-4339.

WORKING WITH DATA

Action Shortcut
Complete an entry and move to the next cell [Enter]

Insert a new line within a cell [Alt][Enter]

Enable editing within a cell [F2]

Fill selected cells with an entry you type [Ctrl][Enter]

Cancel an entry [Esc]

Fill data down through selected cells [Ctrl]D

Fill data through selected cells to the right [Ctrl]R

Create a name [Ctrl][F3]

Insert a hyperlink [Ctrl]K

Insert the current date [Ctrl] and ;

Insert the current time [Ctrl] and :

Action Shortcut
Cut the selected text or objects [Ctrl]X

to the Clipboard
Copy the selected text or objects [Ctrl]C

to the Clipboard

Paste the contents of the Clipboard [Ctrl]V

Repeat last action [Ctrl]Y

Undo last edit [Ctrl]Z

Delete from the insertion point to the [Ctrl][Delete]
end of the line

Add blank cells [Ctrl][Shift]+

Delete selected cells [Ctrl]- 

Create a chart from a range of data [F11]

FAST ACCESS WORKSHEETS

When working with large workbooks in which all of the
worksheet tabs are not visible, it's easy to become frustrated
scrolling back and forth trying to find the sheet you need. Here's
a faster way: Right-click on any of the tab-scrolling buttons (to
the left of the sheet tabs), and a shortcut menu will pop up with
all the tabs listed. You can then select the tab you want.

QUICK PRINT AREA SETUP

There's no point sending entire worksheets to the printer if all
you need is a printout of a few columns or rows. To quickly set a
print area, follow these steps:
1. Go to View | Page Break Preview.
2. Select the cells you want to print.
3. Right-click on the selection and choose Set Print Area 

from the shortcut menu.

COMMON WORKSHEET OPTIONS

You can handle a number of typical worksheet chores without
wading through dialog boxes to find the options you need. Just
right-click on a worksheet tab to display a shortcut menu with
commands that let you perform tasks such as inserting,
removing, and renaming worksheets.

A HOST OF AUTOFILL CHOICES

Excel's fill handle feature gives you a number of ways to copy
data from a cell or range into adjacent cells. You can extend this
capability even more by right-clicking on the fill handle before
dragging to select the target cells. When you release the mouse
button, Excel will display a shortcut menu that includes options
such as copying just the formatting, copying cell contents
without formatting, creating a growth or linear series, or entering
a fill series based on the selection.

INSTANT CALCULATIONS

When you need to perform a simple calculation on a range of
cells in a worksheet, you don't have to build a formula to handle
the job. Just select the cells containing the values and then
check out the status bar at the bottom of the window. By default,
Excel will display the sum of the selected values. But you can
right-click on the information in the status bar to bring up a
shortcut menu with options to view the average of the values,
the maximum or minimum value, the number of cells in the
selection that contain an entry, and the number of cells that
contain numbers.

FORMULA SHORTCUTS

Action Shortcut
Begin a formula =

Enter a formula as an array [Ctrl][Shift][Enter]

Display the Insert Function dialog box [Shift][F3]
(Paste Function in Excel 97)

Paste a defined name into a formula [F3]

Insert a SUM AutoSum formula [Alt]=

Insert arguments after a function [Ctrl][Shift]A

Display the Function Arguments dialog box Type a function 
in the Formula 
bar and press 
[Ctrl]A

Action Shortcut
Copy the value from the cell above [Ctrl][Shift] and "

the current cell into the current cell
Copy a formula from the cell above [Ctrl] and '

the current cell into the current cell
Toggle between display of formulas [Ctrl] and `

and cell values
Calculate values for sheets in all [F9]

open workbooks
Calculate values for the current worksheet [Shift][F9]
Cancel an entry you're making in a cell [Esc]

or in the formula bar

HANDY RIGHT-CLICK SHORTCUTS
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TIPS AND TRICKS

This is a single-user version, and duplication is prohibited. For additional copies, please call 1-800-217-4339.

OPEN MULTIPLE WORKSHEETS
One of the challenges of working in Excel
is viewing all the information you need,
especially since it often lives in different
worksheets. Here's a simple way to view
multiple sheets:

1. Click on the tab of the worksheet you 
want to view.

2. Go to Window | New Window.

3. Repeat this process for each of the
worksheets you want to display. (Excel
opens each sheet in a window that sits
on top of the previous one.)

4. To see them all at one time, choose
Arrange from the Window menu.

5. Select Tiled, Horizontal, or Vertical.

6. Select the Windows Of Active
Workbook check box.

7. Click OK.

SELECT NONCONTIGUOUS TEXT
When you need to select cells or ranges
that aren't next to each other, try this:
After making your first selection, hold
down [Ctrl] as you make the additional
selections.

WHAT'S THIS DO?
If you're unsure about the action of a
particular button or command, you can
find out in a hurry. Simply press [Shift][F1]
and then click a button or pull down a
menu and choose a command. Excel will
display a brief description of the specified
item.

CHANGE THE WAY THE [ENTER] 
KEY WORKS

Many Excel users don't like moving down
a cell when they press [Enter]—they'd
rather move to the right or stay in the cell
after completing an entry. Excel
accommodates such preferences. To
change the behavior of the [Enter] key, go
to Tools | Options and click the Edit tab.
Then, select the direction you want from
the Direction drop-down list. If you want to
prevent the [Enter] key from moving to
another cell, deselect the Move Selection
After Enter check box. After you set the
desired specifications, click OK.

KEEP EMBEDDED CHARTS IN PLACE

If you make major changes to a
worksheet that contains an embedded
chart, the size and location of that chart

could be affected. To avoid this, select the
chart area and click Format Chart Area
on the Chart toolbar. Then, click the
Properties tab, select the Don't Move Or
Size With Cells option, and click OK.

SIZE A CHART ON A SHEET
When you create a chart sheet, Excel
automatically sizes the chart to occupy
the whole page—so how can you resize
the chart? First, activate the sheet and go
to File | Page Setup. Then, select the
Chart tab, choose Custom, and click OK.
Now, you can resize the chart by
selecting the chart area and dragging a
handle.

GRAB JUST ONE DATA MARKER
Clicking on a data marker, like a column
or bar, selects all the markers in that data
series—which is no help if you want to
change only that single marker. To avoid
selecting all the markers in the series,
click twice (slowly) on the marker you
want to select. On the second click, Excel
will deselect all but the marker you want.

PRINT CELL COMMENTS
If you've added comments to a
worksheet, you can easily print them
along with your worksheet data. You have
a couple of choices here: You can either
print the comments on their own page or
print them as they appear on the
worksheet. If you opt for the second
approach, make sure they're visible. If
they aren't, just go to View | Comments.

When the time comes to print the
worksheet, go to File | Page Setup and
click the Sheet tab. Select the desired
option from the Comments drop-down list
(At End Of Sheet or As Displayed On
Sheet). To print the worksheet and
comments, click the Print button and 
click OK.

GET A HANDLE
The fill handle—that small black box that
appears in the bottom-right corner of a
selected cell or range—helps you copy
information into adjacent cells with
minimal effort. If Excel recognizes an
entry as part of a series (like a label,
such as Part 1, or a date), it will complete
the series when you drag the fill handle
across or down adjacent cells. Otherwise,

it will copy the original entry. If you hold
down [Ctrl] as you drag, Excel will
increment the entry by 1 across the cells
you select.

CREATE THE CHART YOU WANT
When you create a chart, Excel normally
uses a standard bar chart format, but
you're not stuck with that choice. You can
set Excel to use any chart type you want
as the default. Start by selecting a chart
and going to Chart | Chart Type. Then,
choose a chart type from the list that
appears in the Standard Types tab and
click Set As Default Chart.

CHOOSE CUSTOM GRIDLINE COLORS

Don't like the color Excel uses for cell
gridlines? No problem. Select any
worksheets you want to change and go to
Tools | Options. Click the View tab, choose
a color you like from the Gridlines Color
drop-down list, and click OK.

QUICKLY ENTER DATA IN A RANGE
Excel offers a fast way to enter the same
information in a range of cells. Just drag
across the cells you want to include in the
range. Then, type your entry and press
[Ctrl][Enter]. Excel will insert your entry in
all the cells you selected.

COPY JUST THE FORMATTING
To copy characteristics such as fonts,
shading, and numeric formats from one
cell or range to another without copying
the data too, start by clicking on a cell that
carries the formatting you want. Then,
right-click on the cell's fill handle and drag
across the cells where you want the
formatting to appear. A shortcut menu will
appear when you release the mouse
button, and you can choose Select Fill
Formats (Fill Formatting Only in Excel
XP/2003) to complete the process.

HOP TO A DISTANT CELL
You don't have to scroll for days trying to
locate a cell in a huge worksheet. Just
press [F5] to open the Go To dialog box,
type the address of the destination cell,
such as Z179, or select a range name
from the list box. Click OK, and Excel will
immediately transport you to the specified
cell.
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Q. How do I print only certain worksheets in a workbook?
A. Begin by selecting the sheet tab of each worksheet you want
to print. Just hold down [Shift] and click on each one. (If the tabs
aren't adjacent to each other, hold down the [Ctrl] key as you
click on them.) Excel turns the tabs white when they're selected.
Now go to File | Print, make sure the Active Sheet(s) option is
selected in the Print dialog box, and click OK. Excel will print
each selected sheet on a new page. If you defined print areas
for any of your sheets, Excel will print just those areas.

Q. When I try to enter a fraction in a cell, Excel turns it into
a date. So, for instance, 7/8 becomes 8-Jul. Is there a
workaround for this?
A. You can keep Excel from converting that value to a date by
entering 0, followed by a space and your fraction. Press [Enter],
and Excel will apply the Fraction format to the cell. If you click in
the cell, the formula bar will show you that Excel is storing the
decimal value of your entry.

Q. I need to center a title across a few columns of data in
my worksheet, but the Center button doesn't do what I want.
How can I create a title that spans multiple cells in my
worksheet?
A. Centering titles isn't hard. Let's say you want to center a title
over four columns of data. First, select the four cells located in
the row above the data. Then, click the Merge And Center button
on the Formatting toolbar. Excel will then combine the cells and
apply the centered format. When you type your title, it will
automatically be centered in the merged cell.

Q. I know I can delete a comment from a cell by selecting
the cell and going to Edit | Clear | Comments. But how can I
get rid of all the comments in a sheet at the same time?
A. You just need to add a step at the beginning of the process:
Select all your commented cells by pressing [Ctrl][Shift]O. Then,
go to Edit | Clear | Comments exactly as you do when you're
removing individual comments.

Q. Some of my worksheets contain fairly sensitive data,
which I don't want other employees to see. Is there a quick
way to tuck these sheets out of sight?
A. Go to Format | Sheet and select Hide. When you're ready to
redisplay the sheet, choose the Sheet command again, select
Unhide, and select the hidden sheet from the Unhide Sheet list.

Q. I can't find an option in the Print dialog box for printing
formulas instead of data in my worksheets. Where do I find
this option? 
A. You don't actually need to choose any special options to print
formulas instead of data. Just make sure Excel is displaying
formulas before you print the sheet. Go to Tools | Options, click
the View tab, select Formulas under Window Options, and click
OK. (A quicker alternative is to press [Ctrl]`.) When you turn on
formula display, Excel will widen the columns to show your
formulas. Now, simply go ahead and print your worksheet.

Q. How do I copy the value contained in a cell instead of the
formula that produces that value?
A. Select the contents of the cell and click the Copy button on
the Standard toolbar. Next, click in the cell where you want to
paste the value. Then, go to Edit | Paste Special, select Values,
and click OK. Excel will paste only the value produced by the
formula.

Q. I typically need at least five worksheets in the workbooks
I create, and Excel starts me out with only three. Is there
any way to increase the default number of sheets?
A. Luckily, you don't have to manually add sheets every time you
create a new workbook—Excel will let you determine the
number of sheets you need. Just go to Tools | Options and click
the General tab. In the Sheets In New Workbook text box, enter
the number of sheets you want and click OK. Now, each
workbook you create will start you off with the specified number
of sheets.

Q. Excel drives me crazy by trying to complete entries I
type in a cell. I know I can keep typing to override its
suggested entry, but it's still annoying. Can I turn off this
feature?
A. You can turn off AutoComplete by going to Tools | Options
and clicking the Edit tab. Just deselect the Enable AutoComplete
For Cell Values check box and click OK, and Excel won't try to
anticipate your entries. If you sometimes want to take advantage
of AutoComplete even though it's disabled, hold down [Alt] and
press the down arrow key in a cell to display a list of entries in
the cells above it.

Q. I created an embedded chart on a worksheet, but now I
want to put it on its own sheet. What's the procedure for
moving a chart—or do I have to start over?
A. There's no need to start over; you can easily move your
embedded chart to a new sheet. Start by clicking on the chart
and going to Chart | Location. Select the As New Sheet option,
type a name for the sheet, and click OK. Excel will move the
chart from the sheet it's on and turn it into a new chart sheet.

Q. I need to lock some specific ranges in this sheet I'm
working on, while leaving the rest of the cells unlocked.
How do I do that?
A. You'll need to follow two steps to lock just certain cells in your
worksheet. Step one is to unlock all the cells. To do this, click the
Select All button (the cell where row and column headings meet
in the upper-left corner of the sheet). Go to Format | Cells, click
the Protection tab, deselect the Locked check box, and click OK.
Step two is to lock the desired cells and protect the worksheet.
First, select the cells you want to lock and go to Format | Cells
again. In the Protection tab, select the Locked check box and
click OK. Now, go to Tools | Protection and select Protect Sheet.
Select the protection options you want, set a password (this is
optional), and click OK.

COMMON QUESTIONS
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